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1.0 Starting an Analysis
Starting or Opening an analysis can be done in one of three ways:

1. Creating a new analysis file by pulling data from a file
2. Opening an existing analysis file
3. Creating triangles by entering data manually or by cutting & pasting

The user begins the analysis by selecting Open from the File menu at the top of the screen or by
choosing the folder icon on the toolbar below the menus at the top of the screen. Upon selecting open

the user can choose from these three options.

1.1 Opening a Data File
The Cognalysis™ Reserving System allows for a wide variety of layouts for input data.

When you start a new analysis by opening a data file, you will be able to browse for the file containing
loss information. Currently supported file types are Comma Separated Variable (.csv), and Microsoft
Access Database (.mdb). If the input file is an Access Database file, you will also be prompted to select

the table containing the loss data.

After selecting the appropriate file you will be given the option to filter the data.
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This allows you to import a subset of records from your data source. In this way the data source can be
built in such a way that it includes data for multiple analyses. If you choose to filter data, select the fields
you are interested in filtering by highlighting a field and clicking the right single arrow. Selecting the
right double arrow will select all fields. To remove a single field, highlight the field on the right and hit
the left single arrow (the left double arrow will move all the fields back to the Available Fields box). In
the example shown below, the Line of Business (LOB) and Region fields have been selected for filtering
and have been moved from the Available Fields box to the Data Filter Fields box.

Once the fields for filtering have been selected and the user has selected the OK button, the user will be
given the opportunity to select the values within the selected fields to include in the analysis. In the
example shown on the next page, Auto has been selected for inclusion from the list of unique values in
the data file in the LOB field. Subsequently, the West Region is shown as being selected for inclusion
from the list of unique values in the data file in the Region field.
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If you choose not to filter data, or after you filter data, you will be taken through a series of screens to
assign the fields of data to various data elements (this may occur automatically if the field structure and
names are identical to a previous import). In the screen shown below, we are given the list of fields in
the data file that may be chosen to map to Accident Period.

Input Field Mapping PE|
Incurredf/Accident Period
Select the Field to Map to;
Data Type: Incurred/Accident Penod
(%) |ncurred/sccident Period Accident Period
. Age
) Incurred/tecident D ate Paid
Imcurmed
LOE
Region
Thiz data type i= for
pre-agaregated data.
Acceptable formats are: Y.
YL T M
[ < Back ] [ Mext » ] [ Cancel

The Accident Period can be determined in one of two ways. It can be pre-identified on the source data,
or it can be based on an accident date. If the period is on the source data itself, it must be in acceptable
format (YYYY, YYYYQ, or YYYYMM). If accident date is to be used to build the accident periods, you will
be asked to identify the length of the periods (annual, quarterly, or monthly).

You will next be asked to map Development Period.
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Input Field Mapping

x]

Development Period

Select the Field to Map to;
Data Type: Age

(%) Age Accident Period
Ane

0 Yaluation D ate Paid

[rizurred
LOB
Reqgion

Thiz data bupe iz the age of the
incurred loss in periods
cormesponding to the zize of
the accident/incured period,
e [1.2.3etz]

[ < Back ][ Mext = l [ Cancel ]

Similar to accident period, development period can either exist already on the data source, or it can be
determined using valuation date.

Next you will be prompted to map paid losses. These can be incremental amounts or cumulative
amounts.

Input Field Mapping b_<|

Paid Loss

Select the Field to Map to;

Data Type: Cumulative Paid Loss

(%) Cumulative Paid Loss Accident_Period

Age
() Incremental Paid Loss _

[rizurred
LOB

Region

Thiz data type is for total paid
lozzes from the beginning of
the accident period to the
valuation date or age

[ < Back ][ Mext = l [ Cancel ]

Finally, you will be prompted to map incurred losses (or build them using case reserves + paid).
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x]

Input Field Mapping

Incurred Loss or Case Reserves

Select the Field to Map to;

Data Type: Cumulative Incurred Loss
(%) Cumulative Incumed Loss Arccident_Period
Ange
() Incremental Incured Loss Paid
() Caze Reserve Balance LOE
Reqgion

Thiz data tupe iz far tatal
incurred losses from the
beginning of the accident
period ta the valuation date or
age

[ < Back ][ Mext = l [ Cancel ]

Your options here include mapping a field to cumulative incurred losses, incremental incurred losses, or
case reserve balances.

After mapping each of these elements, you will be given a summary as shown below with the option to
go back and remap as needed.

Upon completion of the mapping, the option to save the layout is provided. When a mapping is saved,
future data imports will automatically recognize if a data source file is of the same format, and make the
appropriate mappings. Since data filtering and length of accident period could vary from analysis to
analysis from within the same data, these questions are asked regardless.
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The next step is the opportunity to import premium or exposure information. If you choose to import
premium or exposure, you will select the file containing the premium or exposure and if necessary
assign the Time Period Identifier and Premium or Exposure Identifier. [If mapping is required, you will be
given a mapping summary and the opportunity to save the layout for future premium importation.] If
you choose not to import premium or exposure, a value of 1 will be used in each period for calculations.

This will be followed by the option to import a previous analysis file. This is the analysis file
corresponding to a previous valuation date. Importing this information has a number of benefits:

e Allow you to start your analysis with previously selected factors, loss ratios, and selected
ultimate losses.

e Allow you to compare actual loss development against previously projected loss development as
well as to compare changes in selected ultimate losses.

If you chose to import a previous analysis file, you will be able to browse for the file.

The user will then be asked to provide a title for your analysis. After entering the title, the setup for the
analysis is complete.

A user may edit the title at any time by simply double-clicking the title shown on the screen.
1.2 Opening an Analysis File

When you start a new analysis by opening an analysis file, you will simply open a previously saved
analysis file by selecting the file from the usual file menu box. The analysis file is the file used by
Cognalysis that contains imported data (paid loss, incurred loss and/or premium or exposure) and any
selections made (loss development factors, seed loss ratios, ultimate values, etc.).
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1.3 Create Triangles

If you choose to create triangles by manually entering data, you will start by defining the characteristics
of the triangle. This includes defining the starting incurred or accident period, the number of incurred or
accident periods and the number of development periods. This allows the user the flexibility to create

triangles in a multitude of period and development increments.

After defining the triangle parameters, the user will then be provided a grid for entering cumulative paid
loss values. The user can type values or paste the values in from clipboard data copied from other
sources. After entering all the paid values, select OK in the lower right corner of the screen.

10
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The user will then be prompted to enter incurred values and exposure or premium values.

The user may then enter a title for the analysis and optionally retrieve a prior analysis.

Return to Table of Contents
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2.0 Editing Data

Users have the ability to edit loss (incurred or paid triangle) or premium/exposure values. The user can
choose the element to be edited from the Edit/Data menu option at the top of the screen or by double
clicking any number of the paid triangle on the Paid LDF screen, any number of the incurred triangle on
the Incurred LDF screen, or any earned premium number on the Paid B-F or Incurred B-F screen.

(£5} Copnalysis™ Reserving System - [Summary of Lltimates Under Different Methods]

Fle [Edt | ¥iew Graphs Tools Help  www.coeonsult.com
H=NES . Chrl+C J
Ind Copy Table  Ctrl+T Reserve Percentiles: o3 42934845
[ Paste Chel+y Maan [Selected) 25% 43,842,592
; — Fesidual | | 44,900,295 50% 44873640
Paid LDF l Paid B-F H Optinize I Results l
[ pas » Paid Triangle Triarigles Optimized Indications  75% 45,928,935
Incurred Triangle Incurred Incurred Methads PWMWSH Changes 44,900,295 90% 46,899,984
Exposure LDF B Summary 99 48519274
Summary of Ulimates Table 3
Eamed Fremium  CunentPaid  Curent Incurred Faid LDF | Incuned LDF PadBF  Incured BF W;‘;;'“’“:g‘ Frevious Selacted Loss Ratio
[RE ] 11,506,094 9563603  10.040632 985,406 10332054 9,324,181 10417365 10392054 10119157 10392054 303%
1338 12,384,141 10,708,011 11,376,077 12024513 11972506 12004513 11722873 12024513 971%
1339 11356614) 10228033 11043409 11,833,751 11,638,141 11,833,751 11566520, 11893751 1047%
2000 11,408,056 9474852 10359005 11,446,701 11183823 11446701 N27EE| 11446700 1003%
2001 10,867,684 3511124 10373275 12575.373 11961495 12575373 12012390 12575373 1157%
2002 16,314,960 9060008 10,634,769 12,790,344 12610537 12790844 1249139 12730944 784%
2003 20233316 7508130 933,245 12678918 12743826  13194737|  12878918| 12698636 12878918 835%
2004 24079420 5307 834 7562,340 12023133 DGR vzoesis| namsns| 121313 4957
2005 24475213 3603477 5303684 12,219,391 12513116 | M4iEREmE 12519016 12s1eEl| 1251911 512%
2006 27496114 1MEEB 4148,434 12,868,435 13,323,534 o o 1zozsse A 1sass 485
Tatal 170182612 76.367,302 sz7o0gen [WOVHIEATGEGE 121858097 12853843 126554869 121868097 | (DEATRESS 121360097 71E%
Summary of Standard Deviations Table
Paid LDF Incuned LDF Paid B Incured BF u
(R BEI 27383 33246 5,043
1998 a1.237 32371 48325 57.781
1399 5,622 32240 77.01 176,469
2000 a33m7 34343 120711 91.297
2001 2434 135,064 188,908 161,361
2002 239,340 4317 454,883 506,092
v
Status

&m0

L) 146pM

After selecting the data element to edit the user will be given a data edit screen. Users can manually

type in new values or paste values from clipboard data copied from other sources. After all values are

edited, the user selects the OK button in the lower right corner to save changes and return to

Cognalysis. The Data Edit screen is shown below.

Return to Table of Contents
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In the case where premium or exposure is being edited, you will be prompted with a question regarding
rescaling of loss ratios.

Rescaling would adjust the seed loss ratio to be consistent with the same level of losses before the
change in premium or exposure.
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3.0 Reviewing and Adjusting Methods

Cognalysis contains four standard techniques commonly used for analyzing ultimates. Those methods
are the Paid Loss Development Method, the Incurred Loss Development Method, the Paid Bornhuetter-
Ferguson Method and the Incurred Bornhuetter-Ferguson Method. Each of the methods as presented
in the model is described below.

3.1 Paid LDF

Users can review and adjust the Paid Loss Development Factor method by selecting the Paid LDF button
in the upper right part of the screen. The paid loss triangle will be shown as entered or imported.
Double clicking on a cell in the triangle will allow the user to edit the values in the triangle. Below the
triangle of loss values, the triangle of age-to-age development factors is shown. The highlighted values
in the age-to-age factor triangle are the factors used in the weighted and simple averages.

143 Cognalysis™ Reserving System - [Loss Development Factor, Method: Paid Loss]

Fle Edt Wew Graphs Tools Help  wwww.cgonsult.com

=y J
Industry H1 Current View Reserve Percentiles: (0% 42,934,545
Mean (Selected)  25% 43842592
Paid LDF l PaidBF ] I Optinize I Results l N
Use Run Optimized Indication;  75%  45.928.935
Teststo rcumed | [ircined | [ Hethed: Pm‘mm] l Changes ||| +43002%5 0% 48833384
Determine N LDF & Summary 99% 48519274
Paid Loss Triangle figel Age2 Age3 Aget Age5 Ageb [ ae8 ge3 Agel0 ~
1997 1094575 2536829 4413384 5396458) 72341758 62850911 8507864 906600V 0297547 O56I509
1338 1301045 3105752 5200734 7114883 8393333 9433845 9993307 10371062 10708011
1999 1460089 3242648 561016 7219154) 6483535 9111399 9813295 10228039
» 2000 1615641 3sezses) smsisn| reaizs) szsrann| esrasz | adarass: [N
2001 1756010 3708860 5786013 7384399 6461272 9511124
2002 1894116 3524704) 5E25241| 7H13173| 5080008
2003 1705261 3564037 5864483 7508130
2004 1850733 3454746 53078
2005 1966.895 3603477
2006 1916518
Age-to-Age Triangle 102 2103 o4 4105 56 607 7108 8103 31010
bo1997 2318 1.740 1.359 1.224 1124 1.0583 1.044 1.024 1.030
1338 2387 1675 1368 1131 1124 1.059 1037 1032
1993 2221 1.715 1.298 1175 1.074 1.077 1.042
2000 2205 1562 1300 1147 1070 1.068
2001 2112 1.560 1.269 1.1582 1124
2002 1861 15% 133 1207
2003 2.090 1.589 1.325
2004 1867 1560
2005 1.832
Farknr Cal 1t ? L) Atnd dmnR Rtk Ftn7 TR Atna Fn 1N THInHII‘ b

Status

1<) 146 P

The factor calculations are shown below the triangle of age-to-age factors. The rows highlighted in
yellow contain the values that may be edited. A description of each row is given below.
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443 Cognalysis™ Reserving System - [Loss Development Factor, Method: Paid Loss]

Fle Edt Wew Graphs Tools Help  wwww.cgonsult.com

En= T |
Industry H1 Current View Reserve Percentiles: 0% 42,334,845
Mean (Selected) 8% 43 842 532
Paid LDF l Paid B-F H Optimize I Resuts l Efasr‘g”l':s' R o 50?’ SRE
Use Fun Optimized Indication:  75% 45,928,335
Teslsto Incumed Incned Methods Pm‘mml l Changss 44,300,235 0% 45.893.984
Determine N LDOF 5 Summaty 9% 48519274
Age-to-Age Triangle T2 2103 Ttod [ GloE Blo7 Tlo8 ECE Sta 10 -
»o1397 2318 1.740 1.359 1224 1124 1.083 1.044 1.024 1.030
1998 2387 1.675 1.368 1.181 1124 1.059 1.037 1.032
1999 2221 1715 1.298 1175 1074 1.077 1042
2000 2.205 1.562 1.300 1.147 1.070 1.088
20m 2112 1,560 1.269 1152 1124
2002 1.861 1.59 1.334 1.207
2003 2030 1589 1.325
2004 1.867 1,560
2008 1832
Factor Calculations IE 2103 T4 4106 5k Gia7 708 [ Sta10 | 10ta Uk
b Periods (] 5 8 7 i 5 4 a 2 1 i
Simple Average 1.994 1625 1.322 1.181 1103 1.084 1.041 1.028 1.030 1,033
Weighted Average 1.985 1618 1.320 1180 1103 1084 1.041 1029 1.030 1033
Regression Facter 1.957 1.593 1.319 1.180 1103 1.084 1.041 1.029 1.030 1,033
Prior Selection 2027 1616 1.321 1176 1.099 1.083 1.040 1.024 1.035 0.000
Selected Age-oAge Facor 1.994 1625 1.322 1.181 1103 1.084 1.041 1.028 1.030 1,033
AgetoUlimale 5762 3391 2087 1579 1337 1212 1138 1.054 1.064 1033
Age-to-Ulimate St Dey 0,687 0217 0.089 0.045 0025 0.010 0.005 0.005 0.004 0.004
Estimated Ulimates 12959495 12219391 11244535 11855337 12113231 11527482 10792016 11183476 11393324 9885408
Ukimate S, Dev 1316298 7R 477EM| BEAT]| 2998 52434 42377 55822 41237 ;WETA
v
Status
77 start. | @ cog Man. U y 3 & ° (:)M( | 1:47 M

Periods (N) — This value can be typed in by the user or it can be set to a default which employs run tests
to determine the length of history to use for factor averages . A run test is performed using all of the
available data points where a run is defined as a series of factors either above or below the median
value. If an insufficient number of runs are observed given total number of data points and the
significance level of the test, then the earliest factor is dropped. This procedure is repeated until the
number of runs is sufficient given the remaining number of data points and the significance level. You
can modify the significance level in the “tools — options — default squaring options” menu item to be
either more stable or more responsive.

In order to set N to the default value, the user presses the “Use Run Tests to Determine N” button
shown toward the top of the screen on the left side.

Simple Average - The simple average of development factors for each period for the most recent N
values (the highlighted values in the age-to-age triangle).

Weighted Average - The weighted average of development factors for each period for the most recent
N values (the highlighted values in the age-to-age triangle).

Regression Factor- The projected future value of the age to age factor based on linear
regression. This regression method employs a stabilizing technique intended to avoid
distortions caused by random fluctuations of data. More information about this technique can
be found at www.cgconsult.com/docs/FactorMethods.pdf. A key parameter in this method is
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the significance level, which can be adjusted in the “tools — options — default squaring options”
menu item.

Prior Selection - If a previous analysis file was imported, this row will be populated with the
development factors from that previous analysis. If a previous analysis file was not retrieved, this row
will be blank.

Selected Age-to-Age Factor- In this row the user will select the incremental development factors. The
user can type values into the cells or double click the row title for one of the averages shown above to
select that set of averages. The user can also double click on any factor within the age-to-age factor
triangle to select that factor for the corresponding period.

Age-to-Ultimate- This row shows the accumulated selected development factors.

Age-to-Ultimate St. Dev- This is the estimated factor to provide the standard deviation of ultimate
losses when multiplied by the current loss amount.

Estimated Ultimates- The estimated ultimate given the current valuation and selected development
factors are presented in this row.

Ultimate St. Dev- This row provides the estimated standard deviation of the ultimate loss.

3.2 Incurred LDF

Users can review and adjust the Incurred Loss Development Factor method by selecting the Incurred LDF
button in the upper right part of the screen. The layout and functionality of this section is exactly like
that of the Paid LDF section. Please refer to the Paid LDF section above for further explanations.

3.3 Paid B-F

Users can review and adjust the Paid Bornhuetter-Ferguson method by selecting the Paid B-F button in
the upper right part of the screen. As in the Paid LDF section, the Paid Loss Triangle is shown at the top
of this section. Below the triangle, the B-F calculations are listed. Each row in this calculation area is
described below.
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143 Cognalysis™ Reserving System - [Bornhuetter-Ferguson Method: Paid Loss]

Fle Edt Wew Graphs Tools Help  wwww.cgonsult.com

En= T |
Industry H1 Current View Reserve Percentiles: 0% 42,334,845
Mean (Selected) 8% 43 842 532
Paid LDF l PaidB-F ] I Optimize I Resuts l Efasr‘g”l':s' R o 50?’ SRE
Select Seed Optimized Indication: ~ 75% 45,928,335
Loss Ralios Incumed Incned Methods Pm‘mml l Changss 44,900,295 0% 45.893.984
Dynamically LDF BF Slufily 9% 4BE19.274
Paid Lass Triangle Agel Age2 Aged Aged Age5 Aaeb Age? Aged Aged Age1l
> 1997 1094575 2536829 A413384| 53965458 7341758 8250911 GEETE64)  A0S6007 9287547 96909
1398 1301045 3105752 5200784 7114889 8399399 9439845 9398307 10371082 10708011
1399 1460089 3242648 GEELOTG| 7219154| 9483535 9111338 981323 10228039
2000 1615641 3562864 5565190 7.232129| 67297800 B674527| 9474992
2001 1756010 BF0S660)  BTSE0N3|  7344399| 8461272 9511134
2002 1894116 3524704 5625241 7503179 9,060,008
2003 1705261 3564037 GEG44E3|  7H0E130
2004 1850733 3454746 5,387,894
2005 1566895 3E034TT
2005 1916518
B-F Calculations 2006 2005 2004 2003 2002 2001 2000 1399 139 1357
»  Eamed Premium 27496114 24475213 24079420 20293316 16314960 10,867,694 11409055 11356614 12384141 1150809
Percent of Ultimate 14.8% 235% 479% 633% 8% 825% &7.6% 91.4% 94.0% 96 8%
Frior Seed Loss Ratio 0.0% B7.7% 0% 732 4.4% 4.4% 74.4% 2% 8.9% 936%
Selected Seed Loss Riatio B1.6% 64.9% B3 0% HE: Al 6% TE1% 81.2% a37% 96.3%
Estimated Ulimates 16,347,359 14801988 13918751 | 12743826 12003749 10872845 10534232 11021034 11370810 9924181
5t Dev. Factor 0166 0137 0.090 0,084 0,039 0,022 0014 0.008 0.004 0.004
Ultimate St Dev. 2816670 2182883 1481538 71196066 4548983 168908 120711 7701 43,305 39,216

Status
—_——

iy Start

7] é)u( 1129 1:47 P
;

Earned Premium-The earned premium or exposure that the user imported into the system will be
shown in this row. If the user imported or entered a zero value for premium or exposure, this row will
show zeroes but will use a value of 0.001 for calculations. The user may edit premium or exposure by
double-clicking any premium cell on this page.

Percent of Ultimate- This row shows estimated percent of ultimate based on the selected age-to-
ultimate factor in the Paid LDF section of the analysis. The Age 1 percent of ultimate will be equal to
1/(Age 1 Age-to-Ultimate value).

Prior Seed Loss Ratio- If a prior analysis file was retrieved, this row will show the seed loss ratio used
in the prior analysis. If a prior analysis file was not retrieved, this row will be blank.

Selected Seed Loss Ratio- The user has the option of typing (or copying) in seed loss ratios or using
the “Select Seed Loss Ratios Dynamically” option. If the user chooses the “Select Seed Loss Ratios
Dynamically” button located in the upper left quadrant of the screen, the user will be prompted to enter
a radius as shown in the print screen on the next page.
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This radius is defined as the number of periods before and after the evaluated period to be used in
estimation of the seed loss ratio for that period. The Cognalysis™ Reserving System will use the
minimum variance weighting of paid link ratio and incurred link ratio estimated ultimate losses for the
entire period specified by the radius. The default value for the radius is determined as that radius which
minimizes the variance of the total reserve estimate. The outcome for this process will change each time
new loss development factors are selected. The selected seed loss ratios will only update if you press
the “Select Seed Loss Ratios Dynamically” button.

Estimated Ultimates- This row provides the estimated ultimate given the seed loss ratio. The
estimated ultimate is calculated for each age as (1-Percent of Ultimate)*Premium*Seed Loss Ratio
+Cumulative Loss.

St. Dev. Factor- This is the factor that when applied to the seed ultimate (premium * seed loss ratio)
gives the estimated standard deviation for the ultimate loss.

Ultimate St. Dev.- This row provides the estimated standard deviation of the ultimate loss.

3.4 Incurred B-F

Users can review and adjust the Incurred Bornhuetter-Ferguson method by selecting the Incurred B-F
button in the upper right part of the screen. The layout and functionality of this section is exactly like
that of the Paid B-F section. Please refer to the Paid B-F section above for further explanations.
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4.0 Selecting Ultimates

Users can review indications and select ultimates in the Methods Summary section shown below by

selecting the Methods Summary button in the upper right part of the screen.

\43 Cognalysis™ Reserving System - [Summary of Ultimates Under Different Methods] |:HE‘E
Fle Edit Wew Graphs Tools Help  www,cgconsult.com
BRG] J
Sample Analysis Reserve Percentiles: | 172,420
Mean (Selected) 8% 172,816
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Summary of Ultimates Table

Eamed Premim Cunent Paid | Curment Incurred Paid LDF | Incurred LDF Paid BF Incurred B-F W;’;mz‘

20082 155,338 4605 6E% 38 53788 53467 48,469 arpa0 47,690 07z

Previous Selected Lioss Ratio

20084 159,326 1782 87 @ s1% -1eEE7 49510 49,792 43,792 3137
Total 639,782 18734 SiE3 133 ZIBdES 2800175 198,863 192,043 192,043 300%

Summary of Standard Deviations Table

Paid LDF Incured LDF Paid B-F Incurred B-F

b 20081 2,254 255 1.873.607 E82
20082 2,380 268 1.800.836 27
2008-3 2,50 308 2,209,487 1678
2008-4 2577 x| 2745279 2,296
Peifecty Independent 4,862 583 4,378,586 ams
Perfectly Correlated 9712 1160 8,629,269 5383
Pattially Carnelated 4,862 a75 6,360,828 4329
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For each period, the current data is shown (Earned Premium, Paid and Incurred). The indicated ultimate
from each of the four methods as well as a blended estimate intended to minimize variance (optimal
weighting) is also shown. If a previous analysis file was retrieved the previous ultimates will be shown
otherwise the previous column will contain zeroes. The user can type in a selected ultimate value,
double click on a single cell for a given period to use that value as the ultimate for that period or double
click on a column to use that method as the ultimate for all periods. The implied loss ratio is supplied in
the last column. If Premium was not entered into the model, a value of one is used for loss ratio
calculations. Individual cells for various indications that highlighted in Deep Sky Blue are more than 5%
below the selected ultimate for that period while cells highlighted in Tomato Red are more than 5%
higher than the selected ultimate for that period.

Below the Summary of Ultimates Table, the standard deviations of reserves by period are shown for
each of the four methods. Standard deviations for all years for each method are also provided assuming
three different scenarios of correlations between years (perfectly independent, perfectly correlated and
partially correlated).
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5.0 Reviewing Diagnostics and Reports

Cognalysis offers a variety of diagnostics and reports to help the user refine the analysis being
performed. The diagnostics include graphs and summaries of the optimization routine, results,
projections, residuals, changes and reserve percentiles. A description of each of the available options is
described below.

5.1 Optimization Metrics

The Cognalysis™ Reserving System provides valuable insight into the different levels of variability of
reserve methods arising from using each of the four basic methods of loss development. It also develops
a blended estimate which reflects the potential for diversification across these methods to reduce the
overall uncertainty.

Users can review the details of this analysis as shown below by selecting the Optimize button in the
upper right part of the screen.

143 Cognalysis™ Reserving System - [Optimization of Method Weights]

Fle Edt Wew Graphs Tools Help  wwww.cgonsult.com

E=x= N |
Industry H1 Current View Reserve Percentiles: 1y 42334048
Mean (Selected) % 43842592
Paid LDF l PaidBF ] I Optinize I Resuts l L GRMEES BB CEEW
Optimized Indication:  75% 45,528,935
\nEBnFad \r\:;ged ] gf:r.r?;s I Projections ] l Changes 44,900,295 W e
i 9% 48619274
Methods Optimizatis A
‘Weights Applied to Each Methad
Paid LDF Incuned LDF Paid BF Incurred BF 5t Deviation Estimated Reserve
» o 0333 15341 0.3635 0143 1112587 44857.770 Four Methods Combined
2 00367 11223 -0.0855 o 1.487.082 45,015,038
3 01329 133 0 01981 1330997 4435073 | Thres Methods Combined
4 09543 1} -0.0657 [IRRAES 2276140 38,929,883
5 0 12146 0.2659 04808 1214786 43,073,895
B 00361 1.0361 o o 1546707 45141746
7 0.5761 0 0.0239 0 226683 38411674 Two Methods Combined
8 09555 1} o 00445 2,280,860 38,718,085
g 0 1.0855 00855 0 1,486,140 44,757,447
10 0 11876 0 01676 1.347.834 14.021.057
11 0 0 01408 11408 492,32 50,012,025
12 1 0 0 0 229025 38.211.890
13 i 1 i i 1547.824 44,900 735 O Method Oy
14 0 0 1 0 5604829 46571.033
15 0 0 0 1 5,002,223 49,587 067
Correlation Matiix and St. Dev of Reserves
Paid LDF Incurned LDF Paid BF Incumed BF | 5t Dev of Reserve
b FaidLDF 1.000 0703 0.358 0374 2290.25
Incured LDF 0703 1.000 0520 0708 1547824
Paid BF 0.358 0520 1.000 0318 5604829 v

Status

4 4 start [ 1|22 148 pm

The four common methods discussed above (the Paid Loss Development, Incurred Loss Development,
Paid Bornhuetter-Ferguson, and Incurred Bornhuetter-Ferguson methods) are used to determine the
optimal weighted estimated ultimate.

Given the standard deviation of the reserve using each method, and the correlations matrix for these
methods (both shown at the bottom of the screen), weights can be found that minimize the variance of
the combined estimate. The result is the first row of the Weights table. These weights have the potential
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to be negative for individual methods. While negative factors are an interesting result that bears some
consideration, the Cognalysis™ Reserving System does not allow them for the minimum variance
weighting it ultimately uses. The remaining 14 rows show the systematic determination of the minimum
variance non-negative weighting. Rows 2-5 eliminate one of the methods each and optimizes. Rows 6-11
eliminate two of the methods each and optimizes. Rows 12-15 eliminate three of the methods each and
optimizes. The weighting that is used is the one that minimizes the variance among those with only non-
negative values.

For more information about this technique please see:
www.cgconsult.com/docs/MinVarianceReserves.pdf

5.2 Summary of Results

Users can review the selected ultimate, selected reserve and reserve range percentiles (10“‘, 25" 50t
75" 90" and 99”‘) in the Results section shown below by selecting the Results button in the upper right
part of the screen.

143 Cognalysis™ Reserving System - [Results and Ranges]

Fle Edt Wew Graphs Tools Help  wwww.cgonsult.com
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Radio buttons are available above the table on the left to choose a ratio view or to annualize the values
if a monthly or quarterly analysis was performed.
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5.3 Projected Losses

The Cognalysis™ Reserving System provides projections of both paid and incurred losses. These
projections:

o Tie to the selected accident year ultimate losses (both for paid and incurred)
e Are based on weighted projections of intermediate period loss from the four basic methods
(Paid LDF, Paid BF, Incurred LDF, Incurred BF).

e Rely on past variability by development period to reconcile between method projections, and
selected values.

Users can review the projected paid and incurred losses in the Projections screen by selecting the
Projections button in the upper right area of the screen.

143 Cognalysis™ Reserving System - [Loss Projections]
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On the left side of the screen the projected calendar year payments and incurred loss changes are
shown for the number of periods in the future as was provided for history. These values are the sum of
the each new diagonal added to complete the squared triangle.

To the right of the calendar period projections, the squared triangle is provided. The projected
payments and incurred losses are shown by incurred period and development period (shown with aqua
shading).
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5.4 Residual Triangle

It can be useful when reviewing reserve analyses to consider the residual errors observed from applying
current parameters to past development. Patterns observed in these residual triangles may suggest
changes to selected parameters are needed.

The residual triangles can be viewed by selecting the Residual Triangle button in the upper right area of
the screen. The residuals are provided for each method and older ages can be viewed by using the scroll
bar at the bottom of each method.

Reserving System - [Residual Error Triangles (Actual - Modeled)]

Fle Edt Wew Graphs Tools Help  wwww.cgonsult.com
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5.5 Changes in Ultimate Loss Estimates and Actual vs. Projected

The change in estimated ultimate and the actual paid and incurred loss compared to expected can be
viewed by selecting the Changes button in the upper right area of the screen. If a previous analysis is
retrieved at the start of the analysis, for all but the most recent year change in selected ultimate is
shown by period. Also, based on the projected payments and incurred losses from the previous analysis
the variance of actual versus projected is provided. If a previous analysis is not retrieved, the prior
estimated ultimate and projected losses will be zero.

& Cognalysis™ Resernving System - [Actual ¥s. Projected Incremental Loss, Change to Selected Ultimates]
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5.6 Reserve Percentiles

As can be seen on all screen views in the user manual, the reserve percentiles for all periods combined is
provided in the upper right corner of the analysis at all times. This summary contains the mean
(selected) reserve, the optimal indicated reserve and the reserve at 6 different percentiles. This gives
the user a status of the analysis that can be viewed at all times regardless of which specific screen the
user may be viewing.
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5.7 Graphs

Eight main categories of graphs are available for the user to view and print. The graphs can be accessed
at any time by selecting the desired graph option from the Graph menu at the top of the screen. A
description of each graph type is provided below.

Paid Development — This graph (shown above) shows the paid as a percent of ultimate at each age for
the periods reviewed based on the selected ultimate and projected losses. The historical portion of
each line is black while the projected portion is red. The user can select a specific period to be
highlighted (bold) from the drop down menu on the right. The “up” and “down” arrow keys on the
keyboard will also scroll the user through the different accident periods.

Incurred Development - Like the paid development graph, the incurred development graph shows
the reported as percent of ultimate at each age for the periods reviewed based on the selected ultimate
and projected losses. The historical portion of each line is black while the projected portion is red. The
user can select a specific period to be highlighted (bold) from the drop down menu on the right.

Projection and Revision — This graph (shown on the next page) provides a stacked bar chart that splits
the ultimate loss for each period into each of its components (paid loss, case reserve and IBNR with the
total bar reflecting the ultimate). If a previous analysis has been retrieved, the prior selected ultimate is
also shown, as well as projected values for paid, case, and IBNR reserves to the current point in time. If
the user has performed a quarterly or monthly analysis, double-clicking on a bar will show the quarterly
or monthly view for that period. Once in this view, the user can return to an annual view by clicking the
Back button in the lower right area of the screen.
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143 Cognalysis™ Reserving System - [Projection and Revision]
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Seed Loss Ratios — This graph (shown below) shows a line with the seed loss ratios as well as the loss
ratio implied by each of the four indications for each accident period.
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Ultimate Box —Whisker — This graph shows the selected values for each period while also presenting
the values at various percentiles. The user can choose to view this graph from a reserve or an ultimate
perspective by selecting one of those two options from the drop down menu to the right of the graph. If
the user has performed a quarterly or monthly analysis, double-clicking on a box will show the quarterly
or monthly view for that period. Once in this view, the user can return to an annual view by clicking on
the Back button in the lower right area of the screen.
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Range and Methods — This graph shows a probability density function for the ultimates. This
probability density function is shown in relation to premium, current paid and current incurred values.
Box and whisker graphs for each of the four methods are also added to give the user perspective relative
to the method indications. The user has the option of choosing to view this graph for all periods or for
an individual period by choosing from the drop down menu on the right (or by scrolling through by using

the “up” and “down” arrow keys.
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Paid LDF Perspective — This graph shows the observed paid development factors for each period for a
given age-to-age relative to averages, prior and selected values. The user can select the desired age to
view from the drop down menu to the right.

Graphing can become useless when outlier values change the scale. The user may also exclude or
include such outliers by checking the box to the right.

The shaded gray region that highlights the factors that were discarded in order to calculate the simple
and weighted averages (see section 4.1). The line representing this cutoff may be moved to the left or
right (by clicking and dragging). The lines representing the simple and moving average factors will adjust
accordingly (including on the LDF screen), but the selected factor (and associated line) will remain
unchanged. The selected factor line may also be moved up or down to a new selected value (NOTE: This
will change the selected factor on the LDF pages as well as indications of ultimate loss, projections, etc.).

Incurred LDF Perspective — Similar to Paid LDF Perspective, but for Incurred factors.
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5.8 Reports

Reports can be printed for each of the main screens and graphs discussed above. To select reports for
printing choose Print Setup from the File menu at the top of the screen. The box shown below will
appear for the user to check the boxes of the reports to be printed. The user may also choose to print
any notes added to the analysis by checking the appropriate box.

Print Selections E@@

Reports

[ ] Results Surmmary

[[] Comparizon to Priar Analysis

[ ] Reserve Range Exhibit

[] Indicated and Selected Estimates of Ultimate Loss

[ ] Development of Chain Ladder |ndication - Paid

[] Development of Chain Ladder Indication - |ncurred

[ ] Development of Bamhuetter-Ferguson Indication - Paid
[ ] Development of Bamhuetter-Ferguzon Indication - Incurred
Paid Loss Triangle

Incurred Lozs Triangle

[] Graph: Paid Development

[] Graph: Incurred Development

[ ] Graph: Projection and Revizion

[] Graph: Seed Loss Ratios

[] Graph: Ukimate Bos-whisker

[ ] Graph: Range and Methods

Graph: Paid LOF Perspective

raph: Incurred LOF Perzpective

O ptions
[] Include Mates

[ k. ] [Eancel] [ Header/Footer. ..

The user may also add a Header and/or Footer to the printed reports. After selecting the Header/Footer
button from the Print Setup box, the user may type text in any of the header or footer boxes.
Alternatively, the user can click in any header or footer box and then select the item they wish to have
appear on the report. The options for the header and footer are shown below and include Date, Time,
Analysis Name, Report Name and Page Number.
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Users can preview the reports by selecting Print Preview from the File menu. On the Print Preview
screen the user can adjust the view by selecting from the screen view buttons or page box at the top of
the screen. After previewing the reports, the user can print the reports by selecting the printer button or
they can close out of print preview by selecting the Close button.

31
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5.9 Notes

Users can add notes for documentation purposes on each section of the analysis (except graphs). If the
user selects Notes from the View menu at the top of the screen a box will appear at the bottom of the
screen for the user to type comments into (this area can also be retrieved by selecting CTRL+N). The
notes section is shown on the portion of the screen view circled on the following page.

(£5] Copnalysis™ Reserving System - [Summary of Lltimates Under Different Methods]
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1339 11356614) 10228033 11043409 11.833.751 11,638,141 11,833,751 11566520, 11893751 1047%
2000 11,408,056 9474852 10359005 11.446,701 11183823 11446701 T1TER 11887 1003%
2001 10,867,684 3511124 10,373,275 12575,373 11961495 12575373 12012390 12575373 1157%
2002 16:314.950 9060008 10694769 12790944 1ZEI053 12790944 12491396 12790944 78.4% 1
2003 20233316 7E0R130 5235, 245 T2EESIG 12743826 1R1MTI 12G7RAIE| 12EWESE| 12878318 835%
2004 24,079,420 5387 834 7.962.340 12023133 12023133) 11828875 12023133 439%
2005 24475213 3603 477 B303E84| 12213391 12513116 12E816 1261858 12519116 512%
2006 27.495114 1ME518 4048434 12,359,495 13,323534 1332359 O 1332353 495%
Total 170182612 7ESETE0Z] 927003 e s 3o e 121,858,097 716%
v
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6.0 Batch Processing

In the Cognalysis™ Reserving System, routine triangle processing and report production for a large
number of analyses may be done automatically in batch mode. This can provide a useful first draft
analysis for large amounts of data, providing you information about where there may be issues for more
focused analysis.

In order to build a batch process the user selects the Batch option from the Tools menu at the top of the
screen.
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After selecting Batch, the user will be taken to a screen where an existing batch process can be opened
or a new batch process can be created by selecting one of these options from the File menu at the top
of the Batch screen. Once a batch process is created or edited the user can save this process by
selecting Save from the File menu to be retrieved for future batch imports.

In building the batch process, the user will enter information in each of the following fields:

e Loss File Path — the path of where the loss data file is located

e Loss Table Name — the name of the MS Access table that contains the loss information

e Loss Filter — full string text that filters the field values (for example, LOB=Auto and Region=West)

e Period — the length of the period (monthly, quarterly, or annual)

e Premium File Path - the path of where the premium data file is located

e Premium Table — the name of the table that contains the premium information

e  Premium Filter — full string text that filters the field values (for example, LOB=Auto and
Region=West)

e Analysis Title — the title to be given to this new analysis

e Prior File Path —if any, the location of the previous analysis file

e Save File Path — the path of where this new analysis file should be save

e Print Reports — a list of reports that should be printed upon creating this analysis file

Items in each field (except Period and Analysis Title) can be browsed for by right-clicking in each cell.
This will bring up a menu to aid in your selection.
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Individual rows can be replicated by right-clicking on the row header of the row to be replicated. In this
way a large number of similar entries can be made quickly.

After the batch process has been built, the user can run the process by selecting the Run option in the

lower right corner of the screen.

When building or modifying a batch process, the user can use the Edit options from the menu at the top
of the screen to target certain rows or cells. These Edit options are also available by right-clicking on a
row in the Batch Analysis list.
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7.0 User Preferences

At any time users can define default squaring options or the default file directories. Users can make
changes to these preferences by selecting one of these options from the Options menu under the Tools
drop down menu at the top of the screen.
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7.1 Default Squaring Options

The Cognalysis™ Reserving System offers a variety of default options when you begin to square
triangles. By selecting Default Squaring options from the Tools/Options menu, choices for default
calculations are available to the user. Each of the default options is described below.

Default Calculations

Iritial S elections Stahiztical Threzholds
Ultimates - -

Critic:al % alue for Correlation t-T est 1
(%) Mo Automatic 5 election fHiEalyallis Jar Lansaton i es
) Minimum Y arance Weighted Average [Mywia) Run Test Significance nz2
() Previously Selected Ultimates with Mo Automatic for Most Becent o
() Previously Selected Ultimates with bywa, for Most Recent Age-to-hge Factor Slope Significance 0.5

Development Factors

(%) Simple Average Factors

() Weighted Average Factors
() Regression Factors

) Previously Selected Factors

Seed Loss Ratios
) Dynamic Determination of Lozs Fatios

() Previougly Selected Loss Patios Restore
Default [ 1] 4 l [ Cancel

Ultimates

Users may choose the default ultimate from the following four options:

e No Automatic Selection — The ultimate for each period will be zero until the user selects an
ultimate value.

e Minimum Variance Weighted Average — The ultimate for each period will be the optimized
value that combines methods to produce the minimized variance.

e Previously Selected Ultimates with No Automatic for the Most Recent — The ultimate for each
period will be set equal to the ultimate for the same period from the previous analysis file that
has been imported. For the most recent (and therefore new) period, the ultimate will be zero
until an ultimate is selected.

e Previously Selected Ultimates with MVWA for Most Recent — The ultimate for each period will
be set equal to the ultimate for the same period from the previous analysis file that has been
imported. For the most recent (and therefore new) period, optimized value that combines
methods to minimize variance will be selected.

Development Factors
Users may choose from the following four options for default development factors:

o Simple Average Factors — The starting selected development factors default to simple averages
of historical factors.
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e Weighted Average Factors — The starting selected development factors defaults to loss-
weighted averages of historical factors.

e Regression Factors — The starting selected factors are based on a regression analysis of historical
development (with stability adjustments- see Statistical Thresholds section below).

e Previously Selected Factors — The starting selected factors will default to the development
factors from the previous analysis that has been imported (if available).

Seed Loss Ratios
Users may choose from the following two options for default development factors:

e Dynamic Determination of Loss Ratios — The seed loss ratios are calculated using a moving
average of the paid and incurred link ratio methods. A radius (hnumber of periods before and
after the period) is derived with the goal of determining seed loss ratios that minimize the
variance of the reserve estimate.

e Previously Selected Loss Ratios — The seed loss ratios will default to the seed loss ratios from
the previous analysis that has been imported (if available).

Statistical Thresholds

Some additional parameters guide behavior of particular algorithms within the Cognalysis™ Reserving
System:

e (Critical Value for Correlation T-test — The measured correlations between accident periods are
subject to a test for significance of the relationship against a null hypothesis of zero correlation.
If the test finds the measured relationship insignificant, zero correlation is used. The default
critical value is 1, meaning t-test of values greater than 1 will be seen as significant. You can
lower this number to be more sensitive to measured correlation between accident periods or
raise it to be more stringent with regard to reacting to these measured correlations.

e Run Test for Significance— The default number of periods used in the determination of
weighted and simple average development factors is based on run tests to determine whether
there are changes in development patterns over time. The sensitivity of these run tests is
governed by this parameter, which is the significance level of the test. The default is .5 which
means that 50% of the time the test will reject the null hypothesis (no change over time in
development factors) even when it is true. You can adjust this parameter lower to be less
reactive to changes in development patterns (resulting in longer periods used for the factor
averages) or you can raise the parameter to be more reactive to changes in development
patterns (resulting in shorter periods used for the factor averages).

o Age-to-Age Factor Slope Significance— The regression that can be used to estimate projected
loss development factors is governed by this parameter. A significance test is performed on the
slope (rate of change in factors over time) determined by the regression. When the slope is
found to be statistically insignificant, the result will be a weighted average of factors. When the
slope is found to be significant, the result will be a factor that reflects the trend. The greater the
slope is relative to its critical value, the more slope will be reflected in the calculated factor. You
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can lower the parameter shown in this box to reduce the sensitivity to the observed trend (0 =>
long term weighted averages are used). You can raise the parameter to increase the sensitivity
to the observed trend (1 => the factor completely reflects the observed trend).

7.2 Default Directories

The user can select an existing folder or make a new folder to act as the default directories. A default
directory can be chosen for data files, analysis files and system files. Data files are files containing data
that will be imported into a new analysis. Analysis files contain a saved analysis (after information has
been imported into Cognalysis, parameters and estimates selected, etc.). You can change these default
directories to better streamline your data input and output processes.

System files are files that are used by the Cognalysis system such as working files and user preference
files. Changes to the system files directory are not recommended.
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